Process of Filing I'TR-1 under New Income
Tax e-Filing Portal 2.0

For Filing the ITR you need to download a JSON-based offline utility. ITR-1 can be filed
online also. The following steps are help to file ITR-1 at New e-Filing portal 2.0

STEP 1: After Login we should click on the Dashboard to find out the page where we can file our return
(Click on File Now button)

e-FiIing Anywhere Anyime = %, CallUs v
Income Tax Department, Govemment of Inda NS

Welcome Back, PRIYADARSAN File your return for the year ended on 31-Mar-2021
CHUPS == For Assessment Year 01-Apr-2021 to 31-Mar-2022
XXXXXXXX9214

+91 985333l m - : !

privadars g 'gmail.com

Loggedin As ’
% > Tax Deposit

Self .4

Profile : 75% Completed > Recent Filed Returns

Contact Details Update
Bank Account Update > Pending Actions 0]
Your account is not Secure Account

secure with e-vault

> Recent Forms Filed

Total Qutstanding Demand Nil
> Grievances




STEP 2: Select the Assessment Year

: e-Filing anwhere Anytime = § ol i
Income Tax Department, Govemment of Inda = =

Dashboard > e-File > Income Tax Return > File Income Tax Return

Income Tax Return (ITR)

* Indicates mandatory fields

Select Assessment year *

[ Select - l

2021-22 (Current A Y.) -.;_"___."'—'=| »

2020-21

2019-20

2018-19

2017-18

SETeTT -

STEP 3: After selection of the Assessment Year we should select mode of filing

g. & E e-Filing anynhere Anytine v, Bl A @ a0 PRIYADARSAN SAHU +

Income Tax Depertment, Govemment of Inda Individual

Dashboard e-File ~ Authorised Partners - Services -~ Pending Actions - Grievances -~ SessionTime 3 5 . 3 2

Dashboard > e-File > Income Tax Return > File Income Tax Return

You need to select a mode of filing to proceed

Select mode of filing

(® Online (Recommended)

O Offline (Using HTML Utility)

indi o ., Feedback | Website Policies | Accessibility Statement | Site Map | Browser Support |
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STEP 4: After step 3 you will see the return option (Fresh Income Tax Return or Saved Draft of Income Tax

Return), you can choose Start New Filing

{8 e-Filing aywee aryime e - G ~
@ Tncome Tax Depertmen, Govemment of Inda S Ealie A # o

Dashboard e-File ~ Authorised Partners ~ Services ~ Pending Actions ~ Grievances ~ SessionTime 3 9 . 3 9

Dashboard > e-File > Income Tax Return > File Income Tax Return

Income Tax Return

You have saved draft of Income Tax Return pending for submission

TR Last Draft saved date ALY.
Resume Filing

To file a fresh Income Tax return —

b g Feedback | Website Policies | Accessibility Statement | Site Map | Browser Support |
> nd updated on : 10-Jun-2021

national poral of india Last re

024 * 768 resolution with |atest version of Chrome, nd Internet Ex
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STEP 5: Under this step you can select the status of the Assessee

¢ . . e-FIlIng RS- — @ o 0 PRIYADARSAN SAHU -
Incorne Tax Department, Govemment of Inda R ndividual

Dashboard e-File v Authorised Partners ~ Services v Pending Actions ~ SessionTime 3 7 1 0 5

Dashboard > Filing Returns for ALY. 2021-22

Please select the status applicable to you to proceed
further

Based on your Profile we have pre-selected a status applicable to you.
You may change the status if it is not applicable to you.

@® Individual O Hur (O others




STEP 6: This step provide the option to choose the ITR Form i.e ITR 1 or ITR 4 ( If the Assessee get any

difficulty to choose his ITR Form he can click on the proceed button which help the Assessee to decide his
ITR Form.)

v e-Filing anwhere Anytime s = ” PRIYADARSAN SAHU ~
Eoee ncore Tax Depertment, Govemment of Inda % callus A B A @ Individual

Dashboard e-File ~ Authorised Partners ~ Services ~ Pending Actions ~ SessionTime 3 9 1 5 0

Dashboard > Filing Returns for AY. 2021-22

Income Tax Returns

You need to choose an ITR Form to proceed

Help me decide which ITR Form to file | know which ITR Form | need to file

Proceed > Select ITR Form

Select ITR Form

ITR-1

ITR-4

STEP 7: Select ITR 1 and Click on Proceed with ITR 1

e-Filing anywhere anyime — x a 0 PRIYADARSAN SAHU ~
,_m,,& Income Tax Department, Govemment of Inda b

Individual

Dashboard e-File ~ Authorised Pariners ~ Services + Pending Actions ~ SessionTime 3 8 1 3 7

Dashboard » Filing Returns for AY. 2021-22

Income Tax Returns

You need to choose an ITR Form to proceed

Help me decide which ITR Form to file | know which ITR Form | need to file

|TR_.I )

For individuals being a resident (other than not ordinarily resident) having total income upto Rs.50 lakh, having
Income from Salaries, one house property, other sources (Interest etc.), and agricultural income upto Rs.5000.

(Mot for an individual who is either Director in a company or has invested in unlisted equity shares or in cases
where TDS has been deducted u/s 194N or if income-tax is deferred on ESOP)

Proceed With ITR 1




STEP 8: After finished all the above 7 steps you will see this screen shoot in your screen, then click on Let’s
Get Started

e-Filing anywhers anytine
ooeme Ta Depertment, Govemment of dia

PRIYADARSAN SAHU

Individual

. Callus ~ A | a 4]

Authorised Pariners ~ Pending Actions ~ SessionTime 3 9 1 2 2

Dashboard > Filing Returns for A.Y. 2021-22 > [TR-1

ITR 1 - (Income Tax Return 1)

For individuals being a resident {(other than not ordinarily resident) having total income
upto Rs.50 lakh, having Income from Salaries, one house property, other sources (Interest e

; - )
etc.), and agricultural income upto Rs.5000.

(Mot for an individual who is either Director in a company or has invested in unlisted
equity shares or in cases where TDS has been deducted u/s 194N or if income-tax is

deferred on ESOP) &
1 2 3
Validate your Confirm your Verify &
Returns Return Summary Submit your Return [} A
breakup (Pre-filled) \

Let's Get Started >

STEP 9: Are you filing the income tax return for any of the following reasons? (you can select any one or
more reasons, if it is not available there then you can select the Other Option)

e-Flllng Anywhere Anylime
Income Tax Department, Gevemment of India

e callus v Iy At Qo

Please answer the following questions to proceed
further

Are you filing the income tax return for any of the following reasons?

Taxable income is more than basic exemption limit

Filing return of income due to fulfilling any one or more below mentioned conditions as per Seventh Proviso to
section 139(1): (§)

Deposited amount or aggregate of amounts exceeding ¥ 1 crore in one or more current accounts during the
previous year,

Incurred expenditure of an amount or aggregate of amount exceeding ¥ 2 lakhs for travel to a foreign country
for yourself or for any other person;

Incurred expenditure of amount or aggregate of amount exceeding T 1 lakh on consumption of electricity
during the previous year

Others




STEP 10: After step 8 on pop up Message will come in your screen (We have pre-filled your return based on

information available with the Income Tax Department. Please confirm that the details in each section are

correct to proceed.)

We have pre-filled your return based on information available with the Income
Tax Department. Please confirm that the details in each section are correct to
proceed

STEP 11: (PERSONAL INFORMATION) Your personal Information will be Auto Populated. You can edit

it if you want.

e-FiIing Anywhers Anytime
=l Income Tax Depertment, Govemment of India

Dashboard > Filing Returns for A.Y. 2021-22 > ITR-1 > Validate Your Pre-filled Data > Personal Information

2 3

Validate Return Confirm your Return Verify and Submit
summary

2 3 4 5

Personal Information Gross Total Income Total Deductions Taxes Paid Total Tax Liability

Verify your personal information

Please verify your personal information, contact details, and bank account details to
proceed further

Profile
First Name Middle Name Last Name
Date of Birth Aadhaar Number @ Aadhaar Enrolment ID

. callUs v

PaN ()

A A A |0

* Indicates mandatory fields




e-Filing aywhere Anytime
Income Tax Depertment, Govemment of India

Contact
Details furnished here will be used ommunication purposes
Address Mobile Number
91
Nature of Employment *
Select >

Filing Section ~

Filedu/s i
® 139(1)

Return filed on or before due
date

O 1192)b)

After condonation of delay

O 139(5)

Revised- Return revised after

O 13904
Belated- Return filed after due

date filing original return

Filed in response to notice u/s

QO 139(9)
Filed in response to notice u/s
139(9) to rectify the defect

B
O 142(1)

Return filed against notice u/s
142(1)

QO 153A

Return filed against notice u/s
153A for search assessment

O 148

Return filed against notice u/s
148 for assessment

W callus v g B A d

Email Address

R e N R ot

QO 153¢

Return filed against notice u/s
153C

e-Filing anwhere anyiime
Income Tax Depertment, Govermment of Inda

Are you opting for new tax regime u/s 115BAC ?

QO ves QO nNo

@ Based on your previous response, please furnish following information OR  Edit Response

» Are you filing return of income under Seventh proviso to section 139(1) but otherwise not required to furnish return
of income? (§)




i *‘.v e-Fili NG Anywhere Aryiime N

o
oy Income Tax Depariment, Govemment af India

Bank Details

Please declare details of all bank accounts held in India at any time during the previous year

{excluding dormant accounts)

A Refund will not be transferred to the bank account unless it is pre-validated

XHHX XXk 0479 : XHXX XXX %xx0 383 : XX XXX X¥x1 094 :
Mot pre-validated Mot pre-validated Not pre-validated
Nominated for Refund )i MNominated for Refund )i Mominated for Refund N ]

Do you want to add more bank accounts?

+ Add Another

1. Minimum cne account should be selected for refund credit.

2. In case of Refund, multiple accounts are selected for refund credit, then refund
will be credited to one of the account decided by CPC after processing the return.

3. Please ensure that at least one preferred bank account is pre-validated.

< Back To Summary

Notes:

[

Minimum of one account should be selected for refund credit.

2. In the case of Refund, multiple accounts are selected for refund credit, then the
refund will be credited to one of the accounts decided by CPC after processing
the return.

3. Please ensure that at least one preferred bank account is pre-validated.

Please select Nature of the Employment any one of the following
v Central Government

State Government

Public Sector Undertaking

Pensioners

Others

Not Applicable (eg. Family Pension etc.)

B

AN NI NN



After fill up personal Information a Confirmed mark will come beside Personal Information

e-Fili Mg Anywhere Anytime

. CallUs ~ Y A
Tnoome Tax Dapariment, Government of India ~ Call U A A [« ]

Dashboard » Filing Retums for AY. 2021-22 » ITR-1 » Walidate Your Pre-Filled Data

Validate Return Confirm your Return Verify a

L 2 3 4 5

Personal Information Gross Total Income Total Deductions Taxes Paid Total Tax Liability

Let's validate your pre-filled return

We have pre-filled your return based on infermation available with the Income Tax Department. Please confirm that the
details in each section are correct to proceed

Return Summary '

It's good, keep going...

@ Personal Information @ Confirmed '<:= CHUPS4477C

Includes your Aadhaar, PAN, Contact and Bank details Meodify if required

TO0

rofession, salary, house property, income from other Provide your confirmation ]

@

STEP 12: (GROSS TOTAL INCOME) Your personal Information will be Auto Populated. You can edit it if

you want.

e-Fili NG Anywhere Anytime

%l - ;
all Us ~ Fy
Income Tax Departent, Government af India ~a fed = »Q ﬂ O

Verify your income source details

Please verify your income sources as collected from various sources and proceed.

Income from Salary

i. Gross Salary 0
ii. Less : Exempt Allowances (&) -0
iii. Net Salary (i - ii) 20
iv. Deductions u/s 16 (-}T 0
v. Income Chargeable under the head ‘Salaries’ (jii - iv) T0

Income from House Property

Income fram only one house property can be shown in this ITR

#A  We have prefilled this value from your Form-16 + Add Details Of Breakup
You are required to provide the breakup in order to consider this amount.

Income chargeable under the head 'House property’ TO




e-Filing anywhes anytime .
Tnoome Tax Deparment, Government of India -

b iy ot e
Income from other sources
If you have any other source of income, please add it here.
Gross Total Income 0

Exempt Income
This information is only for reporting purposes.

If you have any exempt income, please add it here

+ Add Details

S e e l

Feedback | Website Policies | Accessibility Statement | Site Map | Browser Support
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2 Income Tax Dej

Note:

You will also be required to enter the remaining / additional details including your
exempt income if any.

STEP 13: (TOTAL DEDUCTIONS) This Tab includes tax-saving deductions or payments under section 80C

or 80D etc. like life insurance, medical premium, pension funds, provident fund, etc.

e-Filing anwhes

Income Tax Department, Goves

e callus ~ Foy Ar [« ]

Deduction

Please provide following information

Are you eligible to claim any deduction for donation paid? G)

Are you eligible to claim any deduction for donation paid for Scientific Research or Rural Development? @

Yes Mo

Are you eligible to claim deduction under section 80GG? @

Yes Mo

Are you eligible to claim deduction in respect of payments made towards life insurance premium and / or Public
Provident Fund and / or 5 Years Tax Saver Fixed Deposit, etc?

( Refer Section 80C )

Yes No




e-FiIing Anywhare Anytime

Income Tax Dapartment, Govemment of India

Are you eligible to claim deduction in respect of payments made towards life insurance premium and / or Public
Provident Fund and / or 5 Years Tax Saver Fixed Deposit, etc?
( Refer Section 80C )

Yes Mo

Avre you eligible to claim deduction u/s 80CCD(2) Contribution to pension scheme of Central Government by employer?

{ Refer Section 80CCD(2) )

Yes Mo

Are you eligible to claim deduction in respect of payments made towards medical insurance premium and / or
preventive health check-up and / or medical expenditure for specified individuals?

{ Refer Section 80D )

Yes Mo

Are you eligible to claim deduction in respect of payment made towards interest on loan taken for higher
education for self and relative?
( Refer Section 80E )

Yes Mo

Are you eligible to claim any other deduction?

_ﬂm

IS

a
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e Tacome Tax Deparmant, Gower e of o

Please add the amount of deduction which is applicable to you ( 1 deductions added )

Deduction type

80CCC - Payment in respect Pension Fund

80CCD(1) - Contribution to pensicn scheme of Central
Government

80CCD(1B) - Contribution to pension scheme of Central
Government

8000-Maintenance including medical treatment of a
dependent who is a person with disability

30D0B-Medical treatment of specified disease

B0EE - Interest on loan taken for residential house property

B0EEA - Deduction in respect of interest on loan taken for
certain house property

B0EER -Deduction in respect of purchase of electric vehicle

80GGC - Donation to Political party

A0TTA - Interest on saving bank Accounts in case of other
than Resident senior citizens

#30U-In case of a person with disability.

Show Less

-

Y

Amount of exemption

A 0

A

>




Incoma Tax Deparmart, Govarreent of Incia

(;g} E'F“El"lg Anywhars Andine —

Validate Return ~onfirm your Return TereE

& 3 3) s

Perscnal Informaticn Gross Total Income Total Deductions Taxes Paid

Verify your deductions

Please verify your deduction details and proceed further

5

Total Tax Liability

If you are entitled to any other claims, please select to claim such eligible deductions

80CCD(2) - Contribution to pension scheme of 800 - Deduction in respect of Health Insurance

central government by employer premia

+ Add 80CCD{Z)

BOGGA - Certain donations for scientific
research or rural development

+ Add 80GGA

Show All Deductions »

Total Deductions

See Detaills »

< Back To Summary

+ Add 80D

BOTTA - Interest on saving bank accounts

+ Add BOTTA

£ B & | O

Nesd Help (F)

BOG - Donations to certain funds, charitable

institutions, etc.

+ Add 806G

0




STEP 14: (TAX PAID) In the Tax Paid section, you need to verify taxes paid by you in the previous year.

Tax details include TDS from Salary / Other than Salary as furnished by Payer, TCS, Advance Tax, and Self-
Assessment Tax.

{g G-Filiﬂg Arywhers Andime =S e =
é \acnme Tax Deparimart, Gover e of neia ~a CallUs *~ A iy >

Validate Return Confirm your Retur Verify and Submit
SUMIMary

E =a =a :E 5

Personal Information Gross Total Income Total Deductions Taxes Paid Total Tax Liability

Verify your taxes paid details

Please verify details of taxes paid by you in the last financial year and procesd further
View your Form 26AS  (§)

Details of Tax Deducted at Source (TDS) on Salary Income (5) Total Tax Deducted
Show Details » 70
Details of Tax Deducted at Source (TDS) from Income Other than Salary () Total Tax Deducted
Show Details » 0
Details of Tax Deducted at Source [As per Form 16C furnished by the Payer(s]] (3) Total Credit Claimed
Show Details » 0
Details of Tax Collected at Source (TCS) () Total Tax Collected
Show Details » 0
Advance tax and Self-Assessment tax payments Taotal advance tax and self assessment tax paid
Show Details » 70
Total Taxes Paid 30

< Back To Summary




STEP 15: (TOTAL TAX LIABILITY)

In case you have Tax Liability, you can choose Pay Now or Pay Later Option.

v' It is recommended to use the Pay Now option. Carefully note the BSR Code and Challan Serial
Number and enter them in the details of payment.

v If you opt to Pay Later, you can make the payment after filing your Income Tax Return, but there is a
risk of being considered as an assessee in default, and liability to pay interest on tax payable may
arise.

L callus ~ Iy Iy 4 ]

{j g e-Filil"lg Anywhare Arylime
e acrm Tax Coparimar, Govarrian of Inei

Validate Return

]

v 4 v 4 (8

Perzonal Information Gross Total Income Total Deductions Taxes Paid Total Tax Liability

Verify your tax liability details

Pleasze verify your tax liability details and proceed further

Computation of Income

Gross Total Income 70
Total Deductions (OEd]
Total Income 20

Computation of Tax

i. Tax Payable on Total Income 70
Your income is taxable in the slab of 0%

Show Calculation >

Shopp Cgle o an

ii. Rebate u/s B7A 0
iii. Tax Payable after Rebate Edli]
iv. Health and Education Cess at 4% 70




o i =
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£E Income Tax Deparimart, Govesmeni of cia wdll LS

v. Total Tax & Cess 70
vi. Relief u/s 89 = 0 |
Relief when =zalary, gratuity i paid in arrears or in advance |
Fill Form 10E te claim relief
vii. Balance Tax After Relief Edli]
viii. Interest u/s 2344 7o
Applicable when return is filed after the due date
Show Calculation »
ix. Imterest w's 2348 (§) 20
Applicable when there is default in pay
Show Calculation >
x. Interestu/s 234C 70
Applicable when ther shortfall in payment of qua y
Show Calculation >
xi. Fee u/s 234F 70
Fees on delay in fi
Total Interest and Fee Payable 30

Show Details >

Total Tax, Fee and Interest
Show Details »

< Back To Summary

20




STEP 16: After verifying all the data you may proceed for Verification. It is mandatory to verify your return,

and e-Verification (recommended option — e-Verify Now) is the easiest way to verify your ITR — it is quick,

paperless, and safer than sending a signed physical ITR-V to CPC by post.

2} e-Filing amwtee ayime
e Ficome Tex Dapart=erd, Govemment of ks

Personal Information  Gross Total Income Total Deductions Taxes Paid Total Tax Liability

Let's validate your pre-filled return

N'e have pre-filled your return based on information available with the Income Tax Department. Please confirm that the
details in each section are correct 1o procesd.

Return Summary

Personal Information & Confirmed
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Gross Total Income & Confirmed
: @ Includes your income from business, profession, salary, house property, income from othar

|“ sources such as bank interest, tc.

Total Deductions & Confirmed

@ Includes tax saving deductions or payment towards life insurance, medical premium, pension
funds, provident fund, etc

s T Paid & Confirmed

_EIEH Includes details of taxes deducted and paid by deductors e.g. employer.
Also includes taxes paid by you £.q. advance tax, self assessment tax

—,  Total Tax Liability & confirmed

Tagl

=q Includes computation of tax you owe to the Government based on your income and

deductions

‘ ¢ Form Selection ‘

You are done! Click Proceed...

CHUPS4477C
Modify if required

30
Modify if required »

30
Modify if required ?

z0
Modify if required }

T0
Modify if required )

&, Download JSON ‘




E E E E‘“F”ing Anywher Anyimea =
You need to make a payment of 30

Please view your Tax Summary details and proceed further

Calculation of Your Taxable Income

A. Gross Total Income
Show Details »

B. Total Deductions
Show Details »

C. Total Taxable Income (A-B)

Calculation of Tax Payable

D. Total Tax, Fee and Interest
Show Details »

E. Total Tax Paid
Show Details »

Amount Payable

Show Details »

< Return Summary

5 Y AQdx 0

l & Print H o, Download l

30

10

0

10

0

30

Preview Return »




E B'Filil"lg Anywham dndime
e Incgm Tax Csparimard, Govaemnnt of ncia

[1] 2

Preview and Submit Verify your Return

Preview and Submit your return

Place (i)

solemnly declare

| ‘ , Son/daughter of

that to the best of my knowledge and belief, the information given in the return is correct and complete

and i in accordance with the provisions of the Income Tax Act 1961, | further declare that | am making

this return in my capacity as Select « | and|am also competent to make this

retum and verify it. | am holding PAN; ‘ ‘

If the return has bezn prepared by a Tax Return Preparer (TRF) aive further details below

|dentification Mo. of TRP

If TRP is entitled far any reimbursement from the
Marme of TRP Govamment, amaourt thereof

| N

¢ Back

* Indicates mandatory fields

Proceed fo Preview




